5.  XE "Vendor Weather Subsystem" \r "D2HBVendor_Weath1" Vendor Weather Subsystem

5.1 Overview

The VW Subsystem, illustrated in the following figure, provides each OASIS site with the ability to simultaneously and continuously ingest, process, and store live weather graphics and radar products from external sources to be disseminated to the AFSSWS Subsystem for display.  The Weather Graphics Server runs the following software applications:

· Harris neX-REAP XE "neX‑REAP"  software 

· WIND Download XE "Download"  Server

· Samba

· Solaris

· Anti-virus
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Figure 5‑1 Vendor Weather Subsystem

The VWS XE "Vendor Weather Subsystem"  ingests, processes, and stores live weather graphics data from the UWDS Hub in Kennett Square, PA and the HWDS Hub in Palm Bay, FL via satellite.

The two components with which the System Administrator is concerned are the Weather Graphics Server and the Unisys Gateway XE "Unisys Gateway"  workstation.  These two components will be addressed in this section.

5.2 Weather Graphics Server

5.2.1  XE "WGS Startup" 

 XE "Startup" WGS Startup

If the Weather Graphics Server is completely powered off, use the following procedure to power up the Server.  Allow approximately five minutes for the WGS to complete the boot process.

1.
At the front panel of the WGS, <Press> the Power Button to the On ( I ) position and wait for the LED to turn green.

NOTE:  The boot process takes approximately five minutes.  During the boot process, maintenance XE "Maintenance"  significant information concerning the system status such as memory status, network connections, and software processes XE "Software Processes"  are scrolled to the screen.

2.
Allow approximately five minutes for the Weather Graphics Server to boot up.  Upon the completion of the boot process, the OASIS Login screen will be displayed.

3.
Login through the OASIS Login screen as necessary.

5.2.2  XE "WGS Shutdown/Reboot" 

 XE "Shutdown" WGS Shutdown/Reboot

In the event that the Weather Graphics Server becomes partially or fully inoperable,  it may be necessary to reboot the equipment to return it to normal operations.  When this is necessary the best option is to perform a graceful shutdown and reboot of the WGS.

Shutdown the WGS using the following procedure:

1.
At the WGS, if not at the neX-REAP XE "neX‑REAP"  Desktop, login as necessary.

2.
<Double-Click> the General Functions icon to display the General Functions menu, shown in the figure below.

3.
<Click> the Shutdown button to display the Shutdown dialog box.

4.
<Click> the Shutdown option button and <Select> System to gracefully shutdown the neX-REAP software.

5.
<Click> the Type option button and <Select> Halt to stop the Server operations then <Click> the OK button.  

6.
<Click> the Shut option button within the confirmation dialog box.  The system will respond with an “Are you sure?” confirmation box. 

7.
<Click> the OK button in the information box to implement the selections and close all dialog boxes. 

8.
The Server will return to the “OK” prompt and become idle, at which time the user may shutdown power to the Server or <Type> boot to restart the Server. 

NOTE:  The boot process takes approximately five minutes.  During the boot process, maintenance significant information concerning the system status such as memory status, network connections, and software processes are scrolled to the screen.
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Figure 5‑2  General Functions Menu

5.2.3  XE "WGS Forceful Reboot" WGS Forceful Reboot

If the Weather Graphics Server is partially locked up and the General Functions menu is unavailable, it may be necessary to perform a forceful reboot of the WGS.  

CAUTION:  Performing a forceful reboot of the Weather Graphics Server may corrupt files.  Always perform a graceful shutdown XE "Shutdown"  using the General Function menu if the capability exists.

To perform a forceful reboot of the WGS:

1.
At the WGS, if not at the neX-REAP XE "neX‑REAP"  Desktop, login as necessary.

2.
<Click> anywhere within the desktop background to display the Root menu.

3.
<Click> the Reboot menu option, then use the cascade menu to <Select> the Reboot WKS option to forcefully reboot the WGS.

NOTE:  The boot process takes approximately five minutes.  During the boot process, maintenance XE "Maintenance"  significant information concerning the system status such as memory status, network connections, and software processes XE "Software Processes"  are scrolled to the screen.

If the WGS is completely locked up, cycling the power on the Server may be the only option.  This should be performed only as a last resort.  It is necessary to wait until the WGS is completely powered off (up to five minutes) before restarting.  The restart also takes up to five minutes.

5.2.4  XE "WGS Status" Monitor WGS Status

The operational status of the WGS is constantly monitored by the neX-REAP software to notify the operator of any change in operational capability.  The health and status of the many software processes and data communications running on the WGS can be monitored through the Status Dialog Box.  This section provides information on using the Alarm XE "Alarm" \r "D2HBAlarm5"  Functions and Status Messages to monitor the status of the WGS.

To Display the Status Dialog Box:

1. At the WGS, if the Alarms dialog box is not displayed, <Double-click> the Alarms icon to display it.  The Alarms dialog box, illustrated below, displays the number of available messages under each of three functions:  Alarms, Status and User.

[image: image3.png]Alms

View

View

View





Figure 5‑3Alarms Dialog Box

2.
Within the Alarms dialog box, <Click> the View button from the Status Message Count section to display the Status dialog box, illustrated below.
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Figure 5‑4  Status Dialog Box

3.
View the Status dialog box.  Under normal operating conditions for OASIS, the Bterm button is red and the Reap1 and Reap2 buttons are normally blue.  Viewing the Status dialog box should offer a good indication of the operational status of the Weather Graphics Server.

Status Dialog Box

The Status dialog box provides an overview of the status of the various processes or components within the server.  All problems detected by the monitoring process are reported to the operator by the changing color of the particular Status area.  The Status window areas employ a color scheme to facilitate recognition of possible errors, problems or notifications.  The colors used and their meanings are listed and described in the table below.

Table 5‑1.  Status Color 

	Color
	Meaning/Action

	GREEN
	Indicates normal operation.  All processes, hardware, queues and data services are sending/receiving the required data.  No operator action is required.

	YELLOW
	Indicates a possible malfunction or error when related to hardware.  When related to software, this status indicates that a process has halted and is no longer operational.  A Yellow code may also indicate a product or service is not available from the source for some reason other than a neX-REAP XE "neX‑REAP"  failure.  The operator should access “View” by < Clicking> the individual button to determine the nature of problem.

	RED
	Indicates a critical problem.  Area colored is no longer operational and immediate operator intervention is required.

	BLUE
	Indicates that the colored area’s status is not being reported even though resource monitoring continues.  This status is set by the operator to curtail the number of error messages generated on a known problem.

	OLIVE
	Indicates the colored area’s status monitoring is in suspension.  This code is set by either the neX-REAP Meteorologist or the Hub operator to stop monitoring this resource during known outage periods.


	  Call Harris Help Desk
	NOTE:  Software processes XE "Software Processes"  may revert to yellow temporarily.  This yellow status indicates that the particular process has stopped.  NeX-REAP software is designed to restart software processes automatically, therefore the yellow status should remain momentarily and then revert to green.  If the Server fails to return to a normal operating condition, notify the Harris Help Desk of the problem.


5.3  XE "Unisys Gateway" \r "D2HBUnisys_Gatew8" Unisys Gateway

The Unisys Gateway PC, also called the Radar Processor, utilizes a Unisys PC to perform NEXRAD XE "NEXRAD"  radar data preprocessing.  The Gateway PC utilizes Unisys WeatherMax software to extract and process the WSR-88D radar and radar mosaic products prior to passing them to the Weather Graphics Server via a 10Base-T Ethernet connection.  

5.3.1  XE "Operational Verification" Operational Verification

To verify that the Unisys Gateway PC is receiving, processing, and outputting data, monitor the WeatherMax Gateway Screen Saver.  There are two different versions of the Screen Saver, as displayed in the following figures.

Screen Saver Type 1
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Figure 5‑5.  WeatherMax Gateway Screen Saver 1

A loss of input data to the Gateway will result in the following conditions:

· A loss of the Throughput Data displayed on the WeatherMax Gateway Screen Saver.

· Throughput (Tput) decrementing to zero.

· Average Throughput (AvgT) decrementing to zero.

A loss of the LAN path between the Gateway and the Weather Graphics Server will result in the following conditions:

· The LAN/WxData’s “Free” column will start to decrement.

· When LAN/WxData’s “Free” column decrements to approximately 55%, the LAN/WxData display will change from white to yellow.

· When LAN/WxData’s “Free” column decrements to approximately 20%, the LAN/WxData display will change from yellow to red.

· After approximately 10 minutes, the LAN/WxData’s “State” column will change from Active (A) to Degraded (D).

Screen Saver Type 2
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Figure 5‑6.  WeatherMax Gateway Screen Saver2

A loss of input data to the Gateway will result in the following conditions:

· In the Gateway Status area of the Screen Saver, the ThroughPut bps displays as zero.

A loss of the LAN path between the Gateway and the Weather Graphics Server will result in the following conditions:

· In the USER STATUS area the Low Buf column will start to decrement.  When it reaches zero, it immediately displays as 100% and remains there.

· After approximately 10 minutes, in the User Status area the Status column will change from active (CONN) to Degraded (DISC).

To Monitor that the Gateway PC is Receiving Data:

Verify that the WGS is receiving both Radar and Radar Mosaic weather products using the Backup NT Server:

1.
At the Backup NT Server (NT 2), <Select> Start>Programs>Accessories>Command Prompt.

2.
At the command prompt, <Type> “Telnet(xx.xxx.xxx.15” ( where xx.xxx.xxx is equal to the Site IP address for your location and 15 is equal to the WGS IP address.).

3.
At the Login prompt, <Type> the appropriate Username (non-privileged) and Password for the WGS. 

4.
At the prompt, <Type> su – Username (privileged) followed by the Password when prompted.  

5.
At the prompt, <Type> rlog or cd(/data/logfiles/recvprod to navigate to the directory /data/logfiles/recvprod.

6.
<Type> ls to view the files within the /recvprod directory and ensure that the files get, nxrhndl and moshndl appear within the directory.

7.
To view the WGS receiving UWDS (nexrad) data, <Type> tail(-f(nxrhndl. The system should respond by displaying a list of incoming nexrad radar products that is being updated every few seconds.

8.
To exit this mode <Press> the Ctrl and C keys, simultaneously. 

9.
To view the WGS receiving UWDS (mosaic) data, <Type> tail(-f(moshndl. The system should respond by displaying a list of incoming radar mosaic products.

NOTE:  Radar (regional) mosaics come in on a cycle of approximately every 5 minutes.

10.
To exit this mode <Press> the Ctrl and C keys, simultaneously. 

NOTE:  For security reasons it is important to end the window session and logoff the WGS and the Unisys Gateway PC when finished. 

11.
When finished, <Type> exit at the prompt and <Press> Enter to log off the privileged user account.

12.
<Type> exit at the prompt and <Press> Enter to log off the non-privileged user account.

13.
<Click> the X button to close the Command Prompt window.

5.3.2 Rebooting the Gateway PC

The following paragraphs describe how to perform a graceful shutdown of the Gateway PC and how to restart it. 

5.3.2.1 To Perform a graceful shutdown of the Gateway PC

1.
Precision 340 running Solaris 8 Operating System: Using the mouse, <Right-Click> on the desktop and <Select> Programs > Command Tool  to bring up a command window. 
OR
Precision 360 running Solaris 9 Operating System:  Using the mouse, <Right-Click> on the desktop and <Select> Tools > Terminal  to bring up a command window.

2.
<Type> su(root to get to the root directory and <Type> the appropriate Password.
3.
At the root directory <Type> halt

4.
When prompted to “press any key to continue”, turn off the computer.

5.
Power down the Unisys Gateway on the front panel of the unit.

5.3.2.2 To Power up the Gateway PC

1.
Power up the Gateway PC on the front of the unit.  When the PC has booted up, the WeatherMax Gateway screen should be displayed (no logon necessary).

5.3.3  XE "Fault Isolation" Fault Isolation Checklist

· If the operational verification fails, check to ensure that the Comstream Receiver has the Power and Sync indicators lit green.  

· If the Comstream indicators are OK but the Gateway is not receiving data, suspect the Unisys Gateway (which includes a GCOM Cable).

5.4  XE "Weather Backup" Weather Backup

An AFSS site can operate in the weather backup mode when its primary source of weather data XE "Weather Data"  has failed.  The weather backup mode will be automatically set when failure of the primary WGS is detected.  Normal operations must be manually selected when the WGS is brought back into service.  

The NT Server’s Download XE "Download"  Client sends weather product request messages out through the Remote Access XE "Remote Access"  Server to the Weather Graphics Server at one of the two DUAT XE "DUAT"  sites (Seattle AFSS or DTC DUAT facility).  The RAS dials a DUAT site and establishes a dial‑up network connection upon receipt of the request messages.

See the Weather Backup procedures in Section 6 to restore weather graphics source to the WGS and discontinue weather backup mode.

See  Section 6 for further details on the types of weather products received in Weather Backup mode.

5.5 Weather Graphics Server Administrative Functions

This section explains the structure of the neX‑REAP XE "neX‑REAP"  application, including items such as logon/logoff, XE "Logon" \r "D2HBLogon10" 

 XE "Logoff"  screen refresh, reboot, emergency procedures, common terminology, GUI components, and a description of the system layout.  

5.5.1 NeX-REAP Application Layout

The WGS is running neX-REAP XE "neX‑REAP" \r "D2HBneX_REAP21"  application software.  Upon a successful login, the monitor will boot up and the following icons will be displayed:

· Current Products XE "Current Products" 
· Self Brief

· Active Alpha

· Product Definition

· General Functions

Additionally, the Alarms XE "Alarm" \r "D2HBAlarm21"  dialog box is opened.

Current Products

The Current Products function displays the following categories of meteorological data:  raw satellite imagery, radar imagery, geographical maps, land/sea boundaries, and other meteorological products.
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The Current Products window allows the user to select the desired class and clipboard, and display the image in the active window.  Four windows can be displayed at a time.  These images can then be manipulated using Clipboard, Functions, Overlay, XE "Overlay"  Animate, View, and Control.  The zoom feature allows the user to enlarge a portion of a region by clicking and dragging on the desired region of the image.

Self Brief

NOTE:  This function is not used for OASIS

The Self Brief function is available for displaying a predetermined sequence of neX-REAP products into a single window. 

[image: image8.png]



Active Alpha

NOTE:  This function is not used for OASIS

The Active Alpha function provides a list of alphanumeric collectives that are currently active.
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Product Definition

NOTE:  In OASIS, this function is used only to delete local graphics.

The Product Definitions function provides the ability to create (learn), modify (edit), print, pause, copy, run, stop, delete, and send product definitions to the Automatic Product Generator (APG) for scheduling.  This provides a method to quickly develop and edit pre-determined products which can then be automatically updated as defined in the APG Scheduling function.
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General Functions

The General Functions icon displays a menu of functions pertaining to the general operation of the neX-REAP application.
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These General Functions, shown in the figure below, include:

· Setup Functions for the neX-REAP application including alpha/user retention, image retention, APG scheduling, alphanumeric collectives, NWS graphic colors, color map setup, filled contour setup, build station packet, status setup, isopleth limit table, symbol editor, station plot rules, SLP template editor, NEXRAD XE "NEXRAD"  site selection, GOES XE "GOES"  switch, and edit fill pattern.

· Delete maps from the neX-REAP database.

· Delete products from the neX-REAP database.

· Send alphanumeric products to the briefing terminals.

· Transmit data to/from the Weather Message Switching Center and the neX-REAP Workstation.  (Not used in OASIS)

· View/print the neX-REAP activity for archived, received and retained products log files.

· Restart/monitor software processes XE "Software Processes"  within the neX-REAP process control list.

· Maintain archive tapes and their contents.

· Reset the neX-REAP hardware devices: dot matrix printer, color printer, Hub Communication Board, and the NEXRAD Communication Board.

· Add, delete, maintain user access to neX-REAP functions.

· Modify individual user passwords.

· Software/Data Download. XE "Download"   

· Housekeeping.  (Not used in OASIS)

· Access word processor (Word Perfect).  (Not used in OASIS)

· Assign ownership/change neX-REAP operations from one user to another.

· Temporarily suspend neX-REAP operations (shutdown XE "Shutdown" ).

· Terminate neX-REAP operations (logout).

[image: image12.png][~[General Functions| -





Figure 5‑7  General Functions Menu

Alarms

The Alarms feature provides information about Alarm Messages, System Status Messages, and User Messages.  

[image: image13.png]



The number of messages are displayed under each of these functions.  <Click> on the View button located in the middle of each section for more information.  Red sections indicate that new messages have been received.

5.5.2  XE "WGS Login/Logout" WGS Login/Logout

Access to the neX‑REAP software on the WGS is controlled by a Logon process.  Users must enter their User ID and Password upon starting the system, rebooting the system, or when following a logoff action from a previous user.  Three Logon levels are available:

· The user logon supports normal user access to the neX‑REAP software.

· The admin logon allows super‑user access, which provides system administration capability on the neX‑REAP software. 

· The view logon allows view only access to the neX‑REAP software.

Login

1.
<Click> the Logon text box.

2.
<Type> your assigned User ID in the “Logon:” text box and <Press> Tab.  The cursor moves to the “Password:” text box.

	3.
<Type> your Password in the “Password:” text box and <Press> Enter.  

  Call Harris Help Desk
	The application confirms authenticity and grants or denies access.  If access is denied, confirm that the correct User ID is being entered and attempt the logon process a second time.  If access is denied a second time, contact the Help Desk.


Logout

The Logout function closes all activities under a specific User ID and terminates interactive access until the next user logs on.  Logout does not terminate the operation of any system software.

1.
<Double‑Click> the General Functions icon.  The General Functions main window is displayed.

2.
<Click> the Logout button.  A confirmation box is displayed indicating that logout will end the user session.

3.
<Click> the OK button in the confirmation box.  The workstation logo is displayed on the screen.  All user interaction is terminated and the OASIS logon screen is displayed.

5.5.3 Changing the WGS Password

Removed for Security Purposes
5.5.4  XE "WGS User Accounts" 

 XE "User account" \r "D2HBUser_account11" neX-REAP User Accounts

To perform the following procedures, the user must be logged on to the WGS with Administrative privileges.  Steps 1 and 2 precede the Add, Modify, and Delete User procedures to advance the operator to the User Accounts window.  The operator must be logged in with Administrator (Admin) privileges.

1.
<Double‑Click> the General Functions icon.  The General Functions main window is displayed.

2.
<Click> the User Accounts button.  The User Accounts dialog box, shown in the figure below, is displayed.
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Figure 5‑8   User Accounts Dialog Box

NOTE:  An active text box or button is outlined in yellow.  <Click> in a text box to  enter data in it. The yellow outline will display and text can be entered.

Add User XE "Add User" 
1.
<Type> the user name to be added in the Enter User Name box.

2.
<Click> the Change Group button to designate the new user’s group (user, admin, or view).

3.
<Click> the Add/Mod User button.  The Password Form pop‑up window requests “New Password:”.

4.
<Type> the new user’s Password in the text box and <Press> Enter.  The Verify Password pop‑up window requests “Verify:”.

5.
<Type> the user’s Password in the text box and <Press> Enter.  The new user’s name appears in the User Names box.

6.
<Click> the Cancel button to close the User Accounts window.

Modify User

1.
Either <Click> on the user’s name in the User Names box or <Type> the user’s name in the Enter User Name box.

If the user’s group is to be changed:

2.
<Click> the Change Group button to select the user’s new group (user, admin, or view).

If the user’s name is to be changed:

3.
<Type> the corrected name in the text box.

4.
<Click> the Add/Mod User button.  The Password Form pop‑up window requests “New Password:”.

5.
<Type> the new user’s Password in the text box and <Press> Enter.  The Verify Password pop‑up window requests “Verify:”.

6.
<Type> the user’s Password in the text box and <Press> Enter.  The revised name or new group appears in the User Names box.

7.
<Click> the Cancel button to close the User Accounts window.

Delete User

1.
Either <Click> on the user’s name in the User Names box or <Type> the user’s name in the Enter User Name box.

2.
<Click> the Delete User button.  The user’s name and group are removed from the User Names box.

3.
<Click> the Cancel button to close the User Accounts window.

Quit neX‑REAP XE "neX‑REAP" \r "D2HBneX_REAP12" 
1.
<Click and Hold> the left mouse button on the desktop background to display the Root Menu.  

2.
<Click> the Quit option on the Root Menu .  

3.
<Click> OK on the Confirm box.  The neX-REAP application will close.

5.5.5  XE "NEXRAD" NEXRAD Site Selection

The NEXRAD Site Selection function selects NEXRAD sites and products to receive into the neX-REAP database.  The products received can be sent directly to the Briefing Terminals via this function.  Selection of this function from the Setup Functions Menu, shown below, displays the NEXRAD Site Selection Setup dialog box shown in the second figure below.  This box displays a matrix of available NEXRAD sites and NEXRAD product count information.  Those sites highlighted in yellow are the NEXRAD sites from which products are currently being received.
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 Figure 5‑9  Setup Functions Menu
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Figure 5‑10   NEXRAD XE "NEXRAD" \r "D2HBNEXRAD15"  Site Setup Dialog Box

Table 5‑2  NEXRAD Site Setup Dialog Box Description

	Label
	Component
	Purpose

	FILE
	Drop-down Menu
	Located at the top of the Site Selection Dialog Box in the Menu Bar.  This Menu Title contains two Menu Items: Save and Quit.  

	SAVE 
	Menu Item XE "Menu Item" 
	Located in the File Menu, this item allows the user to save their changes before quitting the application.

	QUIT
	Menu Item
	Located in the File Menu, this item allows the user to quit the application without saving any of their changes.

	HELP
	Menu Title
	Located at the top of the Site Selection Dialog Box in the Menu Bar.  This Menu Title contains an About Menu Item which displays help on the Site Selection Dialog Box.

	ABOUT NEXRAD
	Menu Item
	Located in the Help Menu, this item displays help on the Site Selection Dialog Box.

	NEXRAD SITES (Not Labeled)
	Matrix Display Buttons
	Display listing all NEXRAD Radar Sites using each Site’s 3-letter Site ID.  Three possible states:

1.  Not Active:  Site is not sending data.  The Radar Call letter is ghosted and the site cannot be selected.

2.  Active, but not Enabled.  Site is sending data but the system is not receiving any of its products.  The Radar Call Letter is not highlighted yellow.

3.  Active and Enabled:  The site is sending data and the system is receiving its products.  The Radar Call Letters is highlighted (yellow).

	Nexrad Product Count Information
	
	Located at bottom of Site Selection Dialog Box and shows the number of current products XE "Current Products"  coming into the system and the number of products sent to the Briefing Terminals.  It also shows the maximum number of products allowed to be received and sent to Briefing Terminals.


Select a NEXRAD Site for Receiving Products:

These steps assume the Setup Functions Menu is displayed:  

1. <Click> the NEXRAD Site Selection button.  The NEXRAD Site Setup Dialog Box (see previous illustration) is displayed.

2. <Click>an unhighlighted NEXRAD Site button.  The NEXRAD Site Configuration XE "Configuration" \r "D2HBConfiguratio16"  Dialog Box is displayed, as shown in the figure below.
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Figure 5‑11  NEXRAD Site Configuration Dialog Box

Table 5‑3  NEXRAD Site Configuration Dialog Box Description

	Label
	Component
	Purpose

	Site Name
	Title Area
	Radar call letters and city of the radar site.

	Receive Nexrad Site
	Radio Buttons
	Displays the current receive status of the NEXRAD site.  YES is receiving products from site, and NO is not receiving products from site.

	Available Nexrad Products
	Matrix Display Buttons
	Displays all available NEXRAD products.   Two states available:  NOT enabled and not highlighted (the product is NOT being received into the system).  Enabled and highlighted (the product is being received into the system).

	
	B1
	Base Reflectivity, 0.5 degrees (Tilt 1)

	
	B2
	Base Reflectivity, 1.5 degrees (Tilt 2)

	
	B3
	Base Reflectivity, 2.4 degrees (Tilt 3)

	
	B4
	Base Reflectivity, 3.4 degrees (Tilt 4)

	
	CR
	Composite Reflectivity

	
	L1
	Layer Reflectivity, sfc/240

	
	L2
	Layer Reflectivity, 240/330

	
	L3
	Layer Reflectivity, 330/600

	
	P1
	1 Hour Sfc Rainfall Amount

	
	P3
	3 Hour Sfc Rainfall Amount

	
	PT
	Storm Total Rainfall

	
	TP
	Echo Tops

	
	V1
	Radial Velocity, 0.5 degrees (Tilt 1)

	
	V2
	Radial Velocity, 1.5 degrees (Tilt 2)

	
	V3
	Radial Velocity, 2.4 degrees (Tilt 3)

	
	V4
	Radial Velocity, 3.4 degrees (Tilt 4)

	
	VA
	Vertical Azimuth Display

	
	VL
	Vertical Integrated Liquid

	OK
	Button
	Retains the NEXRAD Site Configuration.

	Cancel
	Button
	Terminates the Site Configuration Dialog Box and returns the NEXRAD Site Selection Dialog Box.

	Help
	Button
	Displays help on Site Configuration Dialog Box.


3. <Click> the Yes button from the Receive NEXRAD Site function.  The Yes button is highlighted indicating the system is receiving data from this site.

4. <Click> an unhighlighted NEXRAD Product button.  The NEXRAD Product Configuration Dialog Box, illustrated below, is displayed.

5. <Click> the Yes button from the Receive Product function.  The Yes button is highlighted indicating the system is receiving this product.
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Figure 5‑12 NEXRAD Product Configuration Dialog Box

Table 5‑4  NEXRAD Product Configuration Dialog Box Description

	Label
	Component
	Purpose

	Site Data 
	Title Area
	Product data received from the site selected.

	Receive Product
	Toggle Button

(Yes or No)
	Identifies whether the product is received or not received.

	Send To Briefing Terminals
	Radio Button

(Set of 31)
	0 = All Remote Workstations XE "Remote workstation" 
1 = All Local Workstations

2-31  Not used in OASIS 

	Send To All
	Button 
	Sends the product to all of the available briefing terminals (local and remote).

	SELECT  (Color Map)
	Button
	Selects the color map to use for the Briefing Terminal.

	ENTER (Clipboard Directory)
	Text Box
	Enter the clipboard directory.

	Land/Sea Bndy
	Radio and Color Buttons
	Selects land and sea boundaries and color of the boundary to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	Jet Routes
	Radio and Color Buttons
	Selects Jet Routes and color of the route to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	In Flight Advisories
	Radio and Color Buttons
	Selects In Flight Advisories and color of the advisory to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	High Sector Bndy
	Radio and Color Buttons
	Selects High Sector boundaries and the color of the boundary to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	Geopolitical Bndy
	Radio and Color Buttons
	Selects Geopolitical boundaries and color of the boundaries to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	ARTCC Bndy
	Radio and Color Buttons
	Selects ARTCC boundaries and colors of the boundaries to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	Radar Range Rings 
	Radio and Color Buttons
	Selects Radar Range Rings and color of the rings to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	Low Sector Bndy 
	Radio and Color Buttons
	Selects Low Sector boundaries and color of the boundaries to be received on the selected NEXRAD site.  The radio button is set to receive when highlighted.  Click on the Color button to change the current color. 

	User Graphics
	Button
	Displays the Select User Graphics Dialog Box when checked and used in combination with the Select button. 

	Select
	Button
	Selects the product choices made within the radio and color buttons.  Available when User Graphics Radio button is checked in the ON state. 

	OK
	Button
	Retains changes made to the NEXRAD Mosaic Product Configuration Dialog Box and returns to the NEXRAD Mosaic Setup Dialog Box.

	Cancel
	Button
	Terminates the NEXRAD Mosaic Selection Dialog Box function and returns to the NEXRAD Mosaic Setup Dialog Box.

	Help
	Button
	Displays help on Product Configuration Dialog Box .


6.
<Click> the OK button.  The Product’s configuration is updated with the changes.  The NEXRAD Product Configuration Dialog Box closes and the product is now highlighted in the NEXRAD Site Configuration Dialog Box, indicating the product is being received.

7.
<Click> the OK button.  The Site’s configuration is updated with the changes and the dialog box closes.  

8.
<Click> the File menu option in the NEXRAD Site Setup Dialog Box.  The File drop-down menu is displayed.

9.
<Select> the Save and Quit function.  Save and Quit saves the changes and takes appropriate actions to receive the NEXRAD Site.  The NEXRAD Site Setup Dialog Box closes and returns to the Setup Functions Menu.

5.5.6  XE "Alarm" \r "D2HBAlarm59" Alarms

The Alarms function provides notification when there is a problem with part of the VWS XE "Vendor Weather Subsystem"  system.  The Alarms Dialog Box provides alarm notification for the Alarm Message Count, Status Message Count, and User Message Count.  

When there are alarm messages available in one of the three areas, the area is highlighted in red.  The number of messages available in each category is displayed under each of these functions.  More information is available by selecting the View button located below the count in each section.  

To Display the Alarms:

1.  <Double-click> the Alarms icon.  The Alarms Dialog Box, shown in the figure below, is displayed.
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Figure 5‑13  Alarms Dialog Box

5.5.6.1 Alarm Message Count (Alarms)

The Alarm Message Count displays the Alarm Messages Dialog Box.  This dialog box identifies the message number and the message type.  When there are messages available, they will appear in the scroll list area. 

To Display the Alarm Messages

1.  <Double-click> the Alarms icon.  The Alarms Dialog Box is displayed.

2.  <Click> the View button on the Alarm Message Count.  The Alarm Messages Dialog Box, shown in the figure below, is displayed.

[image: image20.png]



Figure 5‑14  Alarm Message Count Dialog Box

3. <Scroll> the Message list and <Select> the desired message.  The Alarm Messages Alphanumeric Text Window, shown in the figure below, is displayed. The Alarm Messages window contains the message number, the date and time of the message, and the message itself.

4. <Click> the Cancel button to terminate the function after making any changes needed.

NOTE:  The user can choose to delete individual files (purge erases all the messages in the message count), print, or go to the next message.
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Figure 5‑15  Alarm Messages Alphanumeric Text Window

Table 5‑5  Alarm Messages Alphanumeric Text Window Description

	Label
	Component
	Purpose

	Next
	Button
	Pages forward to the next message.

	Delete
	Button
	Deletes the currently displayed message.

	Purge
	Button
	Removes all messages from the Alarm Messages file.

	Print
	Button
	Prints the currently displayed message.

	Cancel
	Button
	Terminates the function without saving changes.


5.5.6.2 Status Message Count (Alarms)

The Status Message Count displays the Status Dialog Box, shown in the figure below.  This dialog box provides an overview of the status of the various processes or components within the system.  The VWS XE "Vendor Weather Subsystem"  operational status is constantly monitored by the neX-REAP XE "neX‑REAP"  system to notify the operator of any change which may affect the system’s operational capability. 

New messages are generated to the message clipboard.  These messages provide the operator with the information necessary to determine the nature of the problem and provide any notices of required maintenance. XE "Maintenance"   The contents of the message may be accessed through the View All button or by clicking an individual button.

NOTE:  It is helpful to leave the Status Dialog Box displayed during a session.
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Figure 5‑16   Status Dialog Box

Table 5‑6  Status Dialog Box Description

	Label
	Component
	Purpose

	PROCESS STATUS XE "Process Status" \r "D2HBProcess_Stat63"  MESSAGES
	Buttons 

(set of 44) 
	Displays individual status messages (three of the buttons are blank and unused).  Selection of an individual button displays the status messages for that process/hardware.  Blue Reap0, Reap1, and Reap2 buttons are unused on OASIS.

	View All
	Button
	Opens the message clipboard providing additional information about the processes or components.  The message clipboard identifies the message numbers, date and time of the messages, and the messages themselves.

	Cancel
	Button
	Terminates the Status functions without saving changes.


To Display Status Messages:

1.
<Double-click> the Alarms icon.  The Alarms Dialog Box is displayed.

2.
<Click> the View option on the Status Message Count.  The Status Dialog Box is displayed.

3.
<Click> on any of the individual Process Status colored buttons that indicate a possible malfunction


OR

4.
<Click> the View All button to see the Status Message Scroll List, shown in the figure below. 

5.
<Click> on any message in the scroll list.  The Status Messages Alphanumeric Text Window, also shown below, is displayed.  The Status Messages window contains the message number, the date, the time of the message, and the message itself. 
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Figure 5‑17   Status Messages Scroll List

NOTE:  Messages are sometimes deleted by the system based on retention settings. 

5.
<Click> the Cancel button to terminate the function after making any changes needed.

NOTE:  The most recent message appears first. The user can choose to delete individual files (purge erases all the messages in the message count), print, or go to the next message.
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Figure 5‑18  Status Messages Alphanumeric Text Window

Table 5‑7   Status Messages Alphanumeric Text Window Description

	Label
	Component
	Purpose

	Next
	Button
	Pages forward to the next message.

	Delete
	Button
	Deletes the currently displayed message.

	Purge
	Button
	Removes all messages from the Status Messages file.

	Print
	Button
	Prints the currently displayed message.

	Cancel
	Button
	Terminates the function without saving changes.


Status Color Information

All problems detected by the monitoring process are reported to the operator by a color change of the particular Status area.  The Status window areas employ a color scheme to facilitate recognition of possible errors, problems or notifications.  

Table 5‑8   Status Color Purpose

	Color
	Meaning/Action

	GREEN
	Indicates normal operation.  All processes, hardware, queues and data services are sending/receiving the required data.  No operator action is required.

	YELLOW
	Indicates a possible malfunction or error when related to hardware.  When related to software process this status indicates that a process has halted and is no longer operational.  The operator should access “View” to determine nature of problem.

NOTE:  A Yellow code may also be used to indicate a product or service that is not available due to maintenance XE "Maintenance"  at the source or some reason other than a neX-REAP XE "neX‑REAP" \r "D2HBneX_REAP64"  failure.

	RED
	Indicates a critical problem.  Area colored is no longer operational and immediate operator intervention is required.

	BLUE
	Indicates that the colored area’s status is not being reported even though resource monitoring continues.  This status is set by the operator to curtail the number of error messages generated on a known problem.

	OLIVE
	Indicates that the colored area’s status monitoring is in suspension.  This code is set by either the neX-REAP Meteorologist or the Hub operator to stop monitoring this resource during known outage periods.


Software processes XE "Software Processes"  may revert to yellow temporarily.  This yellow status indicates that the particular process has stopped.  neX-REAP software is designed to restart software processes automatically.  Therefore, the yellow status should remain momentarily and then revert to green.  Should the system fail to return to a normal operating condition, notify the Harris Help Desk. 

Process Status XE "Process Status"  Information

The Process Status area of the Status Message Count Dialog Box is comprised of four rows of eleven areas each.  Rows are used as a grouping technique to separate the processes or components on which status is being reported.  In some cases, more than one row is required to maintain adequate status reporting.  The types of processes and components displayed in the Status window are:

· Software Processes

· Hardware Devices

· Message Notification

· Availability of Data Services.

Table 5‑9  Process Status Descriptions

	PROCESS
	FUNCTIONAL DESCRIPTION
	SYSTEM IMPACT
	CORRECTIVE ACTION

	REAP0
	Monitors the REAP software process on the WGS monitor.
	If yellow, operator is not able to interface with the software, i.e., make menu selections.
	Restart the Reap0 process via Process Control under the General Functions menu.

	REAP1


	Monitors the REAP software process on a remote monitor.
	If yellow, operator is not able to interface with the software, i.e., make menu selections.
	Restart the Reap1 process via Process Control under the General Functions menu.

	REAP2

(Not used in OASIS)
	Monitors the software process on the right monitor.
	If yellow, operator is not able to interface with the software, i.e., make menu selections.
	Restart the Reap2 process via Process Control under the General Functions menu.

	APGDIS
	Dispatches commands to the APG to build scheduled products.
	If yellow, commands are not sent to the APG thereby causing a disruption in product building.
	Restart the APGDIS process via Process Control under the General Functions menu.

	APG00
	Process which monitors the  operational state of the Automatic Product   Generator 00.
	If yellow, the APG00 process has incurred an error and is being restarted.  If process remains yellow, APG00 data will not be available for display.
	Restart the APG00 process via Process Control under the General Functions menu.



	APG01
	Process which monitors the  operational state of the Automatic Product   Generator 01.
	If yellow, the APG01 process has incurred an error and is being restarted.  If process remains yellow, APG01 data will not be available for display.
	Restart the APG01 process via Process Control under the General Functions menu.

	METAR
	Process which monitors the receipt of  the  International Surface Observation (METAR) report data.
	If yellow, no METAR data is received and processed by the system. If process remains yellow, surface aviation observation report data will not be available for display.
	Restart the METAR process via Process Control under the General Functions menu.

	GRIB
	Process which is used to store Gridded Binary data for use by the ISO and STR command strings to graphically display data.
	If yellow, the GRIB process has incurred an error and is being restarted.  If process remains yellow, Gridded Binary data will not be available for use by ISO and STR command strings..
	Restart the GRIB process via Process Control under the General Functions menu.

	NWS_GPH
	Monitors input of NWS_GPH Products.


	If yellow, the NWS_GPH products have incurred an error and are being restarted.  If process remains yellow, NWS_GPH products will not be available for display.
	Restart the NWS_GPH process via Process Control under the General Functions menu.



	FSA
	Monitors formatted SAO process.
	If yellow, the FSA process has incurred an error and is being restarted.  If process remains yellow, APG will not be available for display.
	Restart the FSA process via Process Control under the General Functions menu.



	ALPHA
	Monitors the process which controls the receipt and dissemination of alphanumeric products.
	If yellow, alphanumeric processes have incurred an error and are being restarted.  If process remains yellow, A/N data will not be available for display.
	Restart the Alpha process via Process Control under the General Functions menu.



	SAO
	Process which monitors the receipt of Surface Aviation Observation report data.
	If yellow, no SAO data is received and processed by the system. If process remains yellow, surface aviation observation report data will not be available for display.
	Restart the SAO process via Process Control under the General Functions menu.

	LIGHT
	Process which monitors the receipt of Lightening report data.


	If yellow, no lightening data is received and processed by the system. If process remains yellow, surface aviation observation report data will not be available for display.
	Restart the Lightening process via Process Control under the General Functions menu.



	EXEC
	Monitors the process that installs downloaded data.
	If yellow, then the download XE "Download"  process is not working properly. If process remains yellow, down-load data will not be available for display.
	Restart the Exec process via Process Control under the General Functions menu.

	LISTEN
	Monitors communication between the Server and Workstations processes on the WGS.
	If yellow, then the comm. Processes are not working properly.
	Restart the Listen process.  If the process remains red contact the Harris Help Desk.

	TAPE

(Not used in OASIS)
	Monitors the UNIX operating system as it performs read/write options on the neX-REAP XE "neX‑REAP"   tape drive.
	If yellow, 1 write error has been encountered.  If red, 2 write errors have been encountered in a row.
	Check Tape Drive for no tape, full tape, power off tape drive or any other condition that may cause the tape to respond with an error.

	FTA
	Process which handles Terminal Area Forecast alphanumeric data.
	If yellow, the Terminal Aerodrome Forecast process has incurred an error and is being restarted.  If process remains yellow, alphanumeric data will not be available for display.
	Restart the FTA process via Process Control under the General Functions menu.



	SDUS
	Process which is used to decode radar alphanumeric data.  SDUS represents the first four characters of the World Meteorological Organization Identification (WMOID).
	If yellow, the National Radar Product is not available for display.   If process remains yellow, National Radar Products will not be available for display.
	Restart the SDUS process via Process Control under the General Functions menu.

	UPA
	Process which monitors the receipt of Upper Air Data reports. 
	If yellow, no upper air reports are received or processed by the system.  If process remains yellow, Upper Air Data reports will not be available for display.
	Restart the UPA process via Process Control under the General Functions menu.



	SYNOP
	Process which monitors the receipt of Synoptic Report data.
	If yellow, no Synoptic reports are received or processed by the system. If process remains yellow, Synoptic Report data will not be available for display.
	Restart the SYNOP process via Process Control under the General Functions menu.

	LOGMGR
	Process which writes to log those functions requiring archival activities
	If yellow, functions will not be written to archive logs and tape.
	Restart the LOGMGR process via Process Control under the General Functions menu.

	IMAGE
	Process which sectorizes and remaps GOES XE "GOES"  imagery data as received from the Hub.
	If yellow, satellite imagery will not be displayed properly.
	Restart the Image process via Process Control under the General Functions menu.

	NXRHND1
	Process that decodes and stores individual NEXRAD XE "NEXRAD" \r "D2HBNEXRAD70"  products.
	If yellow, NEXRAD data is not being decoded and stored.  If process remains yellow, NEXRAD data will not be available for display.
	Restart the NXRHND1 process via Process Control under the General Functions menu.

	MOSHND1
	Process that decodes and stores MOSAIC radar products.
	If yellow, MOSAIC data is not being decoded and stored.  If process remains yellow, MOSAIC data will not be available for display.
	Restart the MOSHND1 process via Process Control under the General Functions menu.

	GET
	Process that stores HWDS data stream to disk.
	If yellow, HWDS data stream is not being stored to disk.
	Restart the Get process via Process Control under the General Functions menu.

	HUBMSG
	Process which handles data coming from the Hub to the Workstation processors.
	If yellow, Hub related message data will not be processed.
	Restart the HUBMSG process via Process Control under the General Functions menu.

	GOES 8
	Monitors incoming data from the hub relating to GOES 8 satellite imagery.
	If red, no GOES 8 imagery data will be processed.
	No action.  If data stream out for extended period, notify Harris Customer Service.

	GOES 10
	Monitors incoming data from the hub relating to GOES 10 satellite imagery.
	If red, no GOES 10 imagery data will be processed.
	No action.  If data stream out for extended period notify Harris Customer Service.

	RTL
	Monitoring reception of income Real-Time Lightning data.
	If red, no Real-Time Lightning data will be processed.
	No action.  If data stream out for extended period notify Harris Customer Service.

	DDS

(No longer used)
	Monitors receipt of Domestic Data Service line.
	If red, no Domestic Data Service products are received.


	No action.  If data stream out for extended period notify Harris Customer Service.

	IDS

(No longer used)
	Monitors receipt of the International Data Service information.
	If red, International Weather data XE "Weather Data"  is not processed.
	No action.  If data stream out for extended period, notify Harris Customer Service.

	PPS

(No longer used)
	Monitors receipt of  the Public Product Service data.
	If red, Public Product Service data will not be processed or available for display.
	No action.  If data stream out for extended period, notify Harris Customer Service.

	HRS

(No longer used)
	Monitors receipt of High Resolution Services.
	If red, GRIB data is not available.
	No action.  If data stream out for extended period, notify Harris. 

	NGS
	Process which monitors the receipt of NOAA Port Graphic Service data.
	If red, incoming NOAA Port data will not be processed by the neX-REAP XE "neX‑REAP" \r "D2HBneX_REAP70"   system.
	No action.  If data stream out for extended period, notify Harris Customer Service.

	GWS 
	Process which monitors the receipt of Gateway Unisys Service data. (NEXRAD)
	If red, incoming GWS data will not be processed by the neX-REAP system.
	No action.  If data stream out for extended period, notify Harris Customer Service.

	COMM_

CARDS
	Monitors input signals to the radar communications card.
	If yellow, no radar data is processed.
	Restart NEXRAD Comm. Board via Hardware Resets under the General Functions menu.

	QUEUES
	Process which controls the queuing of commands or requests which are awaiting execution by one or both of the processors.
	If yellow , indicates that the number of commands is approaching the maximum limit, and the queue is  66% full.  If red, indicates the number of commands has exceeded maximum allowed or is 100% full.  Indicative of a system halt or slowdown.
	Determine which process is not taking its messages off the queue by checking the processes monitored under Alarms XE "Alarm" \r "D2HBAlarm70"  status.  Restart the process that is not taking its message off of its queue via Process Control under the General Functions menu.

	MEMORY
	Monitors the amount of memory being used by the system.
	If yellow, indicates memory space is 66% used.  If red, indicates memory space is 95% used.
	Contact Harris Customer Service.



	DISK_

SPACE
	Monitors the amount of space actually used by the system.
	If yellow indicates that 96% of the disk is used.  If red, indicates that 98% of disk space is used.
	Determine which data is filling up the disk by viewing the Alarms Status / Memory message. Lower the retention of this data via the General Functions / Setup Functions / Alpha and User Retention or Image Retention functions.

	NETWORK
	Monitors system activities on the Ethernet.
	If yellow, indicates that a 0.1% error rate is present.  If red, indicates that a 1.0% error rate is present.
	Contact Harris Customer Service.



	BTERM
	Monitors the Briefing Terminals.

(Not used in OASIS)
	If yellow, 1 Briefing Terminal is down.  If red, all Briefing Terminals are down.
	Determine which Briefing Terminal is down by viewing the message under Alarm Status / Bterm.  Reboot the Briefing Terminal.


5.5.6.3 User Message Count (Alarms)

The User Message Count displays the User Messages Dialog Box, shown in the figure below.  This dialog box provides a scroll list of available administrative messages.

The User Messages box provides access to an alphanumeric text window to allow the user to view messages sent from the Hub, make changes to an existing message, obtain hardcopy printouts and delete unwanted material.  Messages sent from the Harris neX-REAP HUB operator are used to notify users of problems, status of system components, and general information.
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Figure 5‑19  User Messages Dialog Box

To Display User Messages:

1.  <Double-click> the Alarms icon.  The Alarms Dialog Box is displayed.

2.  <Click> the View button on the User Message.  The User Messages is displayed.  Any messages available will appear in the scroll list area. 

3.  <Click> on any User Message within the scroll list.  The User Messages Alphanumeric Text Window, illustrated below, will appear containing the message number, the date and time of the message, and the message itself.

4.  <Click> the Cancel button to terminate the function after making any changes needed.

NOTE:  The user can choose to delete individual files (purge erases all the messages in the message count), print, or go to the next message.
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Figure 5‑20   User Messages Alphanumeric Text Window

Table 5‑10   User Messages Alphanumeric Text Window Description

	Label
	Component
	Purpose

	Next
	Button
	Pages forward to the next message.

	Delete
	Button
	Deletes the currently displayed message.

	Purge
	Button
	Removes all messages from the Status Messages file.

	Print
	Button
	Prints the currently displayed message.

	Cancel
	Button
	Terminates the function without saving changes.


5.5.7 Site Local Graphics

Local Graphics can be added to the LOCAL_GRAPHICS class in WIND by saving them to the "I" drive.  These graphics can be scanned in, loaded from a CD, or created in Paint Shop Pro using the Extended Capability Workstation (ECWS).  Specific instructions for using the CD Reader/Writer, scanner, and Paint Shop Pro software are included with the hardware and software.

5.5.7.1 To add a Site Local Graphic 

To add a graphic using Paint Shop Pro:

1.
At the ECWS, <Double-Click> the icon on the desktop to open Paint Shop Pro.

2.
Either create the new graphic in Paint Shop Pro, scan in the graphic, or load the graphic from a CD.

3.
Modify the graphic if necessary.

4.
<Select> File>Save As.  The Save As dialog box appears.

5.
Select the top level of the "I" drive as the saving location, enter a file name (no spaces) and select the desired image type (.jpg, .bmp, or .png).

6.
<Click> Save.  The graphic is copied to the "I" drive, automatically processed, and placed in the "Processed" directory.

If a graphic is ready to import and has been saved in the .jpg, .bmp, or .png format, it can be copied directly to the top level of the "I" drive using standard Windows tools. The graphic will be automatically processed and placed in the "Processed" directory.

5.5.7.2 To Modify a Site Local Graphic

A local graphic can be modified using Paint Shop Pro.

1.
At the ECWS, <Double-Click> the icon on the desktop to open Paint Shop Pro.

2.
<Select> File>Open, and <Select> the "Processed" folder on the "I" drive.  

3.
<Select> the graphic to be modified and <Click> Open.

4.
Edit the graphic as desired.

5.
<Select> File>Save As.  The Save As dialog box appears

6.
Select the top level of the "I" drive as the saving location, enter a file name (no spaces) and select the desired image type (.jpg, .bmp, or .png).

7.
<Click> Save.  The graphic is copied to the "I" drive, automatically processed, and placed in the "Processed" directory.

5.5.7.3 To Delete a Site Local Graphic

A site local graphic should always be deleted from the WGS.  

NOTE:  the file name remains in the clipboard of the local graphics until the next time these products are automatically scrubbed (up to 24 hours).

1.
<Logon> to the WGS.

2.
<Double-Click> the Product Definition icon.

3.
<Click> the button below "Current time" and <Select> Import Products from the list.

4.
<Scroll> to locate the graphic to be deleted, <Select> the graphic, and <Click> Delete.

5.
<Click> OK in the confirmation pop-up window to delete the graphic.

5.5.7.4 To Backup or Restore Local Graphics

Local graphics are backed up or restored by logging on to the NT Server and using Telnet to access the WGS.  See section 3.10 for specific instructions.
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